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1 Introduction
The FreshCon 4.00 system was developed by the University of Stuttgart and TTI GmbH – TGU
Smartmote to analyse the setting and hardening of any kind of materials (especially fresh cement concrete and fresh mortar) by using the ultrasound-analysis. Currently it consists of the
following components:
•
•
•
•
•
•
•

Industrial personal computer
USB data acquisition device (USB-Multifunction-Oscilloscope 4262 with Arbitrary Waveform Generator)
Pulse generator (PIEZOMECHANIK HVP 1000)
USB pulse trigger module (SmartPULSE)
At least two ultrasonic broadband piezoelectric sensors (Panametrics V 601 or comparable)
Different cables for connecting the devices
An optional temperature device (National Instruments 9211 with USB-9162 carrier)

The software for this system was developed with the program LabVIEW 2011 (programming
language G). The FreshCon 4.00 system allows simultaneous data acquisition and onlineanalysis. For enhanced analysis functions with already recorded data there is an offline version
SmartPick 1.70 available.
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2 High-voltage precautions
The high voltage pulser provides output voltages as high as 1000 Volts under normal operating
conditions, so extreme caution must be employed when using the FreshCon system. The
FreshCon system should only be used by individuals who are thoroughly skilled in high voltage
laboratory techniques. The following precautions should always be observed:
1. Keep exposed high-voltage wiring to an absolute minimum.
2. Wherever possible, use shielded connectors and cabling.
3. Connect and disconnect loads and cables only when the high voltage pulser is turned
off.
4. Keep in mind that all cables, connectors, oscilloscope probes, and loads must have an
appropriate voltage rating.
Do not attempt any repairs on the system components, beyond the fuse replacement procedures described in this manual. Contact Smartmote’s technical support if some of the system
components require servicing.
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3 Regularity Notes
The FreshCon system and its components are developed mainly for using it for scientific research in laboratory environments.
The components of the FreshCon system are enclosed in robust chassis and use a filtered
power entry module (where applicable). The main output signal is provided on a shielded connector that is intended to be used with shielded coaxial cabling and a shielded load. Under
these conditions, the interference potential of this instrument is low.
If interference is observed, check that appropriate well-shielded cabling is used on the output
connectors. Contact Smartmote for advice if you are unsure of the most appropriate cabling.
Also, check that the sensors used are adequately shielded. It is necessary to use components,
which are shipped with the FreshCon system only.
If any of the connectors on the high voltage pulser are unused, they should be covered with
shielded metal “dust caps” to reduce the interference potential and to reduce risk of injuries.
This instrument does not normally require regular maintenance to minimize interference potential. However, if loose hardware or connectors are noted, they should be tightened.
Contact Smartmote if you require assistance.

3.1

Declaration of Conformity

The Piezomechanik GmbH, Berg am Laim Str. 6, D-81673 München/Munich, Germany
declare under their sole responsibility that the product
HVP 1000/50 (resp. HVP 1000/20)
to which their declaration relates, is in conformity with the following standards:
EN61000-6-3 and EN61000-6-1 (or other EN standards or national standards to which
the product relates).
Following the provisions of the Electro Magnetic Compatibility Directive 89/336/EEC
and the Low Voltage Directives 73/23/EEC.
And is in conformity with the safety standards EN 61010-1 (Safety requirements for
electrical equipment for measurement, control and laboratory use), EN 60950 (Safety of
information technology equipment.
We TTI GmbH - TGU Smartmote, Pfaffenwaldring 4, D-70569 Stuttgart, Germany
declare under our sole responsibility that the products
SmartPulse and the
FreshCon PC
to which this declaration relates are in conformity with the provisions of the Electro Magnetic
Compatibility Directive 89/336/EEC and the Low Voltage Directives 73/23/EEC.
Pico Technology, James House Colmworth Business Park, St Neots, United Kingdom
declare under their sole responsibility that the product
PicoScope
to which their declaration relates complies with part 15 of the FCC rules.
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The National Instruments Germany GmbH, Ganghofer Str. 70b, D-80339 München/Munich,
Germany
declare under their sole responsibility that the products
NI 9211 and
NI USB-9162
to which their declaration relates, is in conformity with the following standards:
EN61326-2-1 Class A emissions; industrial immunity.
EN55011 Group 1 Class A emissions.
AS/NZS CISPR 11 Group 1 Class A emissions.
FCC 47 CFR Part 15B Class A emissions.
ICES-001 Class A emissions.
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4 Software installation
For the installation of the software several programs and drivers from different manufacturers
are necessary.
FreshCon 4.00.exe needs a LabVIEW 2011 runtime engine, if this runtime engine is not installed on the computer an error will occur.
4.1.1 LabVIEW 2011 runtime engine installation
For installation of the runtime engine run the file
•

LVRTE2011f3std.exe

and follow the instructions.

4.1.2 USB-Picoscope software installation
For the installation of the USB-Oscilloscope software do
not connect the oscilloscope to the PC. Insert the Pico
CD into the CD-ROM drive, the CD should start automatically. Click the
•

Run_Pico.exe

and follow the instructions on the screen and in the Quick
Start Guide manual of the PicoScope. After installation of
the software the PicoScope can be connected and tested
according to the manual.

4.1.3 USB driver installation for the SmartPULSE device
For the installation of the USB driver for the SmartPULSE
device do not connect the device yet. First execute the
•

CDM20824_Setup.exe

that is saved in the FTDI folder. A command window will
appear. After the installation is completed the SmartPULSE
device can be connected to the USB port of the PC.

© Smartmote & Universität Stuttgart

FreshCon V4.00

9

4.1.4 National Instruments 9211A USB temperature
device driver installation
For the installation of the driver for the National Instruments 9211A USB temperature device run the
•

NIDAQ950f2.exe

and follow the instructions. Note that even if you have no
temperature device the driver must be installed.
If you want to use the temperature device connect it to an
USB port of the PC, then open the
•

MAX (Measurement and Automation Explorer)

and check if there is a NI USB-9211A configured as Dev1
found. If there is no device found then use the Refresh
item in the View menu of the MAX.

4.1.5 Installation of the FreshCon Software
Copy the
•

FreshCon 4.00 folder

with all files from the FreshCon DVD to the hard disk of
your computer and make sure that no file is writeprotected.

4.2

FreshCon license

Each FreshCon 4.0 system is protected by a software key belonging to the serial number of the
USB-Multifunction-Oscilloscope 4262, which will be delivered together with the system. If you
want to use a different USB-Multifunction-Oscilloscope 4262 together with the FreshCon software a new FreshCon key is necessary, please contact SmartMote to get a new key code. The
key code can be entered manually in the dialogue or the FreshCon.key file can be replaced by
a new one.
4.2.1 FreshCon Software key dialogue
If the item FreshCon license… from the Help
menu is selected, the Enter FreshCon key dialogue
opens. Enter the key provided by Smartmote and
press OK.
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5 System assembly
Each measurement is controlled by the software FreshCon 4.00, which operates the DAQdevice (DataAcQuisition device) and the SmartPULSE connected by USB to the PC. The DAQdevice (USB-Multifunction-Oscilloscope 4262) is used for logging data of two input channels
simultaneously. The data acquisition is triggered by the SmartPULSE device.
With version 4.00 of the FreshCon system we have introduced a system setup that only requires a PC with MS Windows XP (or MS Windows 7) and two USB ports. One USB port is
used for the SmartPULSE device, the other one for the USB-Multifunction-Oscilloscope 4262.
Due to the fact that the new DAQ device now has 16 bit amplitude resolution and an enhanced
range of preamplification settings the preamplifier used in the former versions of the FreshCon
system is no longer required. If the optional temperature device is used another USB port is
needed.
The SmartPULSE device is designed to simultaneously trigger the data acquisition of the USBMultifunction-Oscilloscope 4262 and the high voltage pulser HVP 1000. The pulse duration is
selectable by the FreshCon software. Therefore, please connect the “Trigger Out DAQ” BNC
output connector to the “EXT” input connector of the USB-Multifunction-Oscilloscope 4262 as
well as the “Trigger Out Pulser” BNC output connector to the “MOD.IN” input connector of the
HVP Pulser.
The USB-Multifunction-Oscilloscope 4262 has got two input connectors (A and B) for directly
connecting two transducers. The sockets and the experimental setup will be explained in the
following. Up to now it is recommended to follow these instructions accurately. Otherwise miscellaneous results can occur.
To the PIEZO sockets of the high voltage pulser one of the transducers for each container has
to be connected. If two measurement containers are to be connected and your system is not
equipped by factory with two PIEZO sockets you additionally have to use the T-type BNC connector provided with the system.

Danger: It is strongly recommended
to switch of the high voltage
pulser if it is not in use!
Note: Be careful when connecting the cables to the apparatus, because when the PIEZO
output of the pulser is connected with any other device than the transducer, it could
cause severe damage to the appropriate device! So it is strongly recommended to check
all connections before starting the system. It is recommended to switch on the high
voltage pulser last.

Note: The transducers provided with the FreshCon system are designed to operate with
input signals in a range of at most 900 Volts! So never use voltages greater than 850
volts to prevent damage of the transducer!
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Fig. 1: System components (components might look different due to user specific customization)
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6 Software setup
6.1

The main window

After start up at first the main window (Fehler! Verweisquelle konnte nicht gefunden werden.) appears. The main window has a title bar, a menu bar and some controls to operate the
program. In the title bar the name and version of the program as well as the last project name
is displayed.

Fig. 2: The main window of the graphical user interface (FreshCon software)

6.2

The menu bar

The menu bar contains several basic items for the configuration and execution of the program.
Five menus
•
•
•
•
•

File
Settings
Measure
Windows
Help

can be found in the menu bar. The File menu contains the items
•
•

Project…
Quit program.

The Settings menu contains the items
•
•

Experimental setup...,
Timing...,
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DAQ...,
Pulser…
Temperature….

The Measure menu contains the items
•
•

Start
Stop.

The Windows menu contains the items
•
•
•
•
•

Time channel 1
Velocity channel 1
Time channel 2
Velocity channel 2
Temperature.

The Help menu contains the item
•

FreshCon license...

The most important items of the menu bar are also available via controls in the upper part of
the main window and can be used alternatively to the menu items.

6.3

The Project… item

If the Project... item from the File menu is selected, the Open project dialogue appears. There is
a drop-down list box labelled Project name where an already existing project can be selected.

6.3.1 The Open project dialogue
A project is a folder on the hard disk where all files related
to a measurement like data files and setting files are stored
in an adequate way (ASCII format). In the text boxes Project path and Description the path to the project and a description is shown.
Finally the Open project dialogue can be closed by using
the OK or the Cancel push button.
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6.3.2 The New project dialogue
With the push button New project the New project dialogue
is opened. A new project can be generated by entering a
name in the text box Project name and by selecting a valid
Project path with the Open Folder button near the Project
text box. Additionally a description to the project can be
entered in the Description text box.
With the OK or with the Cancel button the New project
dialogue is closed.
Note: After initial installation of the FreshCon 4.00
software it is necessary first to create a new project
with a valid project path.

6.3.3 The Delete project dialogue
To delete existing projects the Delete project button in the
Open project dialogue must be used. The Delete project
dialogue will appear where an existing project can be selected with the drop-down list box and deleted with the OK
button. Note that all associated data and setting files will
be removed from the volume. Of course the Delete project
dialogue can also be closed without deleting files by using
the Cancel button.
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The Experimental setup… item
6.4.1 The New experimental setup dialogue
With the New experimental setup button the associated
dialogue window is opened. Similar to the New project
dialogue a setup name and a description can be entered.
Additionally a picture can be selected if there is one available. The picture must be a “jpg”-type and must be saved
in the FreshCon folder. With the No. of containers dropdown list box one or two containers can be selected, depending on this selection the system measures only on
one channel or on both channels. With the two drop-down
list boxes First and respectively Second container name
the correct container can be selected. If there is no suitable
container a new container can be created with the New
container button or an already existing container can be
modified with the Modify container button.
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6.4.2 The Experimental setup dialogue
With the Experimental setup... item from the Settings menu
the Experimental setup dialogue can be opened. There is a
drop-down list box labelled Experimental setup name
where an already existing experimental setup can be selected. With the New experimental setup button a new
setup can be created, while with the Modify experimental
setup button an already existing setup can be modified.
The Delete experimental setup button allows deleting an
already existing and no longer used setup. Each of this
buttons opens a dialogue window to operate the system.
There is an already existing experimental setup named
•

Combined S-P

that is well suited for a two channel measurement with two
containers.
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6.4.3 The New container dialogue
The picture on the left shows the window of the New container dialogue. Each container has a unique container
name and two sensors that can be selected from the First
sensor and from the Second sensor drop-down list box.
The distance between the two sensors respectively between the PMMA plates of the container must be measured and entered in the Distance [m] numeric control. Also
the delay time and the reference energy should be measured for correct analysis and entered in the associated
control. It will be explained later how to make a correct
calibration of a container.
There are already existing two predefined containers
named
•
•

P-Wave and
S-Wave

that are well suited for a two channel measurement.

6.4.4 The New sensor dialogue
If the actually used sensor does not exist in the drop-down
list box of the New container dialogue a new sensor can be
created or an existing sensor of the New container dialogue can be modified. With the New sensor button the
associated dialogue is opened. A unique sensor name and
if necessary a serial number for that sensor can be entered
in the text boxes. After a new sensor was created it can be
used in the New container or Modify container dialogues.

6.4.5 The Delete sensor dialogue
Sensors as well as containers that are no longer needed
can be deleted from the system with the Delete sensor
respectively Delete container dialogue. Please note that
you should not delete a container that was/is used in an
experimental setup and that you should not delete a sensor that was/is used by a container.
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The Timing… item

With the Timing... item from the Settings menu the Timing dialogue can be opened.
6.5.1 The Timing setting and dialogue
There is a drop-down list box labelled Timing setting name
where an already existing timing setting can be selected.
With the New timing setting button a new setting can be
created, while with the Modify timing setting button an
already existing setting can be modified. The Delete timing
setting button allows deleting an already existing and no
longer used setting.
There is an already existing timing setting named
•

beton

that can be used for all standard mixtures without any
accelerator or fast hardening cement.
Depending on the mix to be tested it may be useful to
modify the settings or to create new settings for each individual test.
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6.5.2 The New timing setting dialogue
With the New timing setting button the associated dialogue
window is opened. A timing setting name can be entered
here. With the No. of time intervals control up to five time
intervals can be selected, each time interval can have a
different number of measurements and a different time
steps Δt. The duration of the selected time interval is calculated by the number of measurements and the time step
Δt and displayed by the indicator Duration for selected
time interval. The total time that is displayed by the indicator Total duration is the sum of the durations of each time
interval.
With the numeric control Signals per test there is an averaging function available, e.g. three single measurements
are made one after another in a short time and the average of the three measurements is calculated. To reduce
the data volume the control Save only average can be set
to Yes. If this function is set to No there will be a folder in
the result path(s) where all single not averaged measurements for each testing time are stored separated in folders
labelled with the number of the test.
Note that the recording and averaging of the single
signals need some time so if this feature is used the
time step setting Δt should not be set too short, otherwise it may be possible that the measurements cannot follow the time step settings.
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The DAQ… item

With the DAQ… item from the Settings menu the DAQ dialogue can be opened.
Note: If filter settings are changed the system must be readjusted with the calibration
procedure.

6.6.1 The DAQ settings dialogue
In the DAQ dialogue the time base settings for the data acquisition board that define the size and the frequency resolution of each measurement can be changed. There is a dropdown list box labelled DAQ setting name where an already
existing DAQ setting can be selected. With the New DAQ
setting button a new setting can be created, while with the
Modify DAQ setting button an already existing setting can be
modified. The Delete DAQ setting button allows deleting an
already existing and no longer used setting.
There is an already existing DAQ setting named
•

Standard

that can be used for most mixes to be tested.
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6.6.2 The New DAQ settings dialogue
With the New DAQ setting button the associated dialogue
window is opened. A DAQ setting name can be entered here.
With the Blocklength drop-down menu the number of samples
that are recorded for each measurement can be changed.
The Samplerate drop-down menu defines the sampling rate
while the Pretrigger samples drop-down menu defines the
number of samples recorded before a trigger signal occurs. A
suitable value for the pretrigger setting is about ten percent of
the whole blocklength. Please also note that the automatic
signal onset picker requires 1000 samples as pretrigger.
The Recorded time of the measurement in µs is calculated by
the reciprocal of the sampling rate multiplied with the block
length, whereas the Pretrigger time in µs is calculated by the
reciprocal of the sampling rate multiplied with the Pretrigger
samples. The DAQ-device of the FreshCon system is up to
now able to work with a maximum sample rate of 10 MHz.
With the Change filter settings button a digital FIR filter (finite
impulse response) can be used. A dialogue window Filter
settings opens when the Change filter settings button is
pressed and the filter settings can be adjusted. The filter algorithm is an FIR windowed coefficients algorithm. The filter type
can be selected with the Filter settings drop-down list, lowpass, highpass, bandpass, bandstop and no filter are available. With the controls Cut-off frequency, High cut-off frequency, B-Factor and Filter coefficients the filter response can
be tuned. The amplitude and phase response are displayed in
the associated graphs.
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Pulser… item

With the Pulser… item from the Settings menu the Pulser dialogue can be opened.
6.7.1 The Pulser settings dialogue
There is a drop-down list box labelled Pulser setting name
where an already existing pulser setting can be selected.
With the New pulser setting, Modify pulser setting and
Delete pulser setting buttons a new setting can be created
or an already existing setting can be modified or deleted.
There is an already existing pulser setting named
•

beton 1

that can be used.
The pulser voltage must be manually set on the front
panel of the HVP 1000-50 with the aid of the ten-turn potentiometer, the control Pulser voltage [V] in the Pulser
dialogue should be set to the same value then.

6.7.2 The New Pulser dialogue
In the New pulser or Modify pulser dialogue the pulse
width of the external high voltage pulser HVP 1000-50 can
be set with the associated control. The minimum pulse
width is given by 2.5 µs and the maximum by 16 µs. According to the experiments conducted in the course of the
development of FreshCon a value of 5 µs seems to be
suitable for almost all experiments. Higher values are only
necessary for highly damping materials.
The pulser voltage must be manually set on the front
panel of the HVP 1000-50 with the aid of the ten-turn potentiometer, the control Pulser voltage [V] in the New
pulser dialogue should be set to the same value then.
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The Temperature… item

With the Temperature… item from the Settings menu the Temperature dialogue can be
opened.
6.8.1 The Temperature settings dialogue
There is a drop-down list box labelled Temperature setting
name where an already existing temperature setting can
be selected. With the push buttons New temperature setting, Modify temperature setting and Delete temperature
setting a new setting can be created or an already existing
setting can be modified or deleted.
There are already existing temperature settings named
•
•

Standard and
Temperature off

that can be used.

6.8.2 The New temperature settings dialogue
In the New temperature setting dialogue up to four channels can be configured for temperature measurement.
With the On/Off radio buttons the associated temperature
channel can be switched on or off and with the drop-down
list box TC type the correct thermocouple type can be
selected. The standard type of the thermocouple is T. The
different TC types depend on the materials of the conductor pair of the thermocouple. The FreshCon system is
provided with thermocouples of type T.

There is an optional calibrated isolation container for the FreshCon system available, in which
the predefined amount of 1575 g concrete or mortar mixture can be filled. The container is
made for measuring the temperature without any external influences like the changing of the
ambient temperature. For example, one can measure with one channel the temperature of the
environment, with another channel the temperature of the mixture in the PMMA FreshCon container and last the temperature in the isolated container and compare them.
The temperature is written in an ASCII file in the result directory with the file extension .tem.
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Starting a measurement

With the push button
•

Start

on the Main window or with the item Start from the Measure menu the measurement can be
started.
6.9.1 Existing measurement data check
If the project path that was selected in the project settings is
not empty a dialog appears asking to delete all files in the
result path. With the Cancel button the start of the measurement will be aborted, but if the OK button is pressed all
files in the result directory will be deleted and the measurement will start.

6.9.2 Zero time definition
Before the measurement starts another dialog will appear
asking for an input of the zero time of channel 1 and channel
2.
The zero time is the time from adding water to the cement
until starting the measurement with the FreshCon system.
This time will be the initial time in the graphs for the calculated velocity etc. If only one channel is used, the zero time
of channel 2 should be set to zero.

6.9.3 End of measurement
To indicate the end of the measurements a message is displayed.

Note: After starting the first measurement it is not any longer possible to change or
modify the settings of the running experiment.
If the measurement is running it can be aborted with the push button
•

Stop

on the Main window or with the item Stop from the Measure menu. If the measurement is not
aborted a dialog window indicating the End of measurement will appear after the last measurement was done.
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6.10 Displaying the results during a measurement
There are several windows to display the results of the measurement. These windows can be
opened or closed before the measurement is started or while the measurement is running with
the push buttons Time Ch1, Time Ch2, Velocity Ch1, Velocity Ch2 and Temperature which are
located on the Main window or via the corresponding items in the Windows menu.
If Time Ch1 respectively Time Ch2 is selected the associated window (Fig. 3) is shown. The
time signal in the upper part of the window shows the amplitudes in volts recorded by the
transducer over the signal length in milliseconds specified during the experiment. The red cursor position correspond to the automatically determined onset time of the p--wave. The blue
cursor can be used for additional time measurements of the time signal. Both cursors can be
changed manually; the X-position of the cursors is displayed in the indicators at the left side of
the time signal.
Below the X-position indicators there is a LED bar with eleven LEDs corresponding to the eleven preamplifier ranges of the PicoScope 4262, whereas the most right LED belongs to the lowest (most sensitive) range and the most left LED belongs to the highest range. The LED that is
lightened up corresponds to the actual selected range.
On the right hand side of the time signal, the cursor controls can be found. Clicking the
zoom lens symbol gives various possibilities for changing the zoom in the time signal.
The cursor changes into a zoom tool. The cross symbol activates the standard cursor
tool, which allows changing the set cursor positions. Selecting the hand symbol permits to shift
the entire graph position within the given limits and without changing the zoom.

Fig. 3: The window Time signal channel 1 (channel 2 is identical)

6.10.1 The p-wave onset picker
The picker for the determination of the p-wave onset is based on the Akaike Information Criterion (AIC)1. It was adapted to ultrasonic signals by Kurz, Große and Reinhardt2. The developed
autoregressive AIC-picker first creates an envelope time function ( ) via the Hilbert transform
( ) from the time signal ( ) as

1

AKAIKE, H.: A new look at the statistical model identification. IEEE transactions on automatic control,
vol. AC-19, no. 6, 1974.
2
KURZ, J.H.; GROßE, C.U.; REINHARDT, H.W.: Strategies for reliable automatic onset time picking of
acoustic emissions and of ultrasound signals in concrete. Ultrasonics, vol. 43, pp. 538 - 546, 2005.
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( ) + ( )

( )

Hilbert transform

( )

time signal
current timestep

( )

envelope time function

In the envelope time function, a simple threshold level set by the Threshold AIC is used to pick
an onset window. The size of the window is specified by the parameters Window upper bound
and Window lower bound. These parameters define a number of samples before and after the
located time in the envelope time function corresponding to the AIC threshold level.
(

The AIC function
(
where

)=
(

) is then calculated for the selected window as

⋅ log

)

(

, 1)

+(

−

(1 +

− 1) ⋅ log

,

)

AIC function within the selected window
time within the selected window
time signal within the selected window
maximum time of the selected window

(

, 1)

(1 +

the variance of
,

) the variance of

from the current value of
between 1 +

and the

On the basis of this AIC function a second window is cut in which AIC lower bound and AIC
upper bound define the number of samples that where cut at the beginning and the end of the
AIC function. Within the remaining window the point of the minimum is determined, which then
equals the estimated onset time of the time signal (see figure below). This second cutting of the
window is sometimes needed if certain noise (e.g. electromagnetic interference at the very
early stage of concrete hardening) lead to multiple minima in the AIC function.

In FreshCon V4.00 the p-wave onset picker is located in the lower part of the Time signal
channel 1 window, it shows the envelope time function (white) and its corresponding AIC func© Smartmote & Universität Stuttgart
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tion (red). The yellow cursor indicates the point where the specified threshold level is exceeded. The two gray cursors are related to the preceding and succeeding samples. To change the
AIC parameters, either the values in the input boxes can be changed, or the cursors in the AIC
graph can simply be shifted to the desired values.
To the right of the graph, cursor controls like described for the time signal can be found.

6.11 The Velocity window
If Velocity Ch1 respectively Velocity Ch2 is selected from the main window or the Windows
menu the associated window (Fig. 4) is shown. The p-wave velocity is calculated from the Distance and the Delaytime defined by the container and the picked onset time for each time signal by the formula

=
and is displayed in the graph versus the time set in the timing dialogue. Distance, onsettime,
delaytime and the p-wave velocity of the actual measurement are additionally displayed in the
indicator boxes at the left side of the graph.
To the right of the graph, cursor controls like described for the time signal can be found. Additionally there is a legend control where the color and the style of the curve can be changed by
clicking on this control.

Fig. 4: The Velocity channel 1 window
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6.12 The Temperature window
If Temperature is selected from the main window or the Windows menu the associated window
is shown. The temperature values of the temperature channels selected in the temperature
dialogue are displayed in the graph versus the time set in the timing dialogue. Fig. 5 shows a
typical temperature plot where TC0 (blue plot) measures the temperature in the container and
TC1 (red plot) measures the ambient temperature.

Fig. 5: The Temperature window

6.13 The settings file
The settings are stored as an ASCII-file in the result path, so it is possible for each user to have
a look to settings of even older experiments. Such a file, labeled as settings.txt, is shown in Fig.
6. In this settings file all necessary settings are shown. Using this file it is also possible to
change some parameters like the calibration parameters or the Zero time later.
The analysis software SmartPick 1.70 reads this file for each project. And if, for example, the
calibration parameters or the zerotime picker were set wrong, it is possible to reset the parameters by changing them in the settings file.

Fig. 6: The settings file
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7 Calibration of the system
For correct analysis results it is recommended to make a calibration of the system. First the
distance between the PMMA plates of the currently used container(s) should be measured
exactly e.g. with a calliper.
The delay time can be measured by putting a calibration standard for p-waves between the two
PMMA plates of the container instead of the mortar or the concrete material. However, also
other calibration methods might be useful; if e.g. no standard is available it is also possible to
put the PMMA plates respectively the sensor surfaces directly together. The coupled surfaces
should be covered with glycerine or silicon grease to assure correct contact. The onset time
measured in this way is exactly the time (dead time correction) the system needs for operation.
Later this delay time will be subtracted from the onset time and so the real runtime of the signal
through the specimen material is calculated for the velocity plots.
As in this FreshCon version no energy analysis is implemented the value for the reference energy should be set to exactly 1.
Note: The calibration is only valid for a certain test setup with a specific setting and so it
is strongly recommended to record the settings of the devices to the calibration parameters. If any setting has changed, for example the voltage or the pulse width of the pulser
these calibration parameters might change. This is especially true if filter settings are
changed.
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8 Measurement system setup
8.1

Test container preparation

The test containers provided with the FreshConDuo version are designed to operate with compressional wave as well as shear wave transducers. The main improvements of the new test
containers are:
•
•
•

Transducer encapsulation to provide better robustness
Direct sensor coupling to the test mix though a ultrathin Polyimide foil for better coupling, less interference and signal distortion
Flexible sensor fixing avoid decoupling due to early age shrinkage

In the following the test container preparation procedure is presented to obtain good test results. It is recommended to follow the instructions carefully:
1. Unscrew the test container and clean up the sidewall and the sensor surface with water
and a fat-dissolving agent (agent should not dissolve PMMA) (see Fig. 7).
2. Take the Polyimide foil and glue it to the test container. Start with gluing from the bottom edge. If you come into the region of the sensor press the foil with a finger onto the
piezo element (see. Fig. 11). The foil must be absolutely flat in the area of the piezo
element. Try to avoid any air bubbles or wrinkles on the sensor surface. If the foil has
full contact to the sensor use the nail of your finger to fix it properly.
3. Glue the foil onto the rest of the container. It does not matter if some wrinkles are in the
foil or air bubbles are between the PMMA sidewall and the foil. It is only important that
the foil is glued in a way that the transducer is protected from water from the test mix
getting to the sensor.
4. Use a cutter to cut off the Polyimide foil at the edges of the PMMA sidewall and prepare
the second PMMA sidewall the same way.
5. Assemble the test container by using the distance nuts (25 mm or 50 mm) and the rubber foam. Please note that the cables of the sensors should show in the same direction,
because correct polarity of the shear wave transducers is important for the further
analysis.
6. The test container is now ready for use.

Fig. 7: Sidewall of test container with implemented sensor.
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Fig. 8: Placing the Polyimide foil (1).

Fig. 9: Placing the Polyimide foil (2).

Fig. 10: Placing the Polyimide foil (3).
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Fig. 11: Placing the Polyimide foil (4), avoid air bubbles.

Fig. 12: Cutting the Polyimide foil.

© Smartmote & Universität Stuttgart

32

FreshCon V4.00

33

Fig. 13: Test container ready to use.

8.2

Test procedure

The following steps describe a procedure that is proven to be sufficient for testing most concrete mixes.
1. Clean the test container and check for damages of the Polyimide foil and correct coupling of the sensors. Place a very thin layer of formwork release oil onto the sidewalls
and the rubber foam, but do not put it onto the sensor surfaces.
2. Close the test container with the screws.
3. Start the FreshCon software and make the initial software settings.
4. Prepare a mix to be tested.
5. Fill in the mix into the test container. Put the rubber foam pieces provided with the container on top of the mix. Do not forget to place the TC0 thermocouple in the middle of
the material by putting it through the rubber foam.
6. Press down the rubber foam.
7. Start the measurement (for details see chapter 0).
8. When measurement is finished, strip the test specimen, measure the exact thickness of
the test mix specimen and correct, if needed, the thickness for correctly calculating the
velocities. If measured thickness is different from the initial value, velocities have to be
calculated again with the correct value.
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9 Appendix
9.1

Further developments

I would be glad to accept wishes and new ideas in respect to the further development of this
program. The next experiments will show which further changes or enhancements are required
anymore. Please do also refer detected software bugs to:
Gerhard Bahr
Institute for Construction Materials
University of Stuttgart – Tel. (+49) 711/68567685
Pfaffenwaldring 4; D-70550 Stuttgart (Germany)
bahr@iwb.uni-stuttgart.de
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